EXPERIMENT 8

Titration Curve for a Monoprotic Acid

INTRODUCTION

A titration reaction is the study of an acid-base reaction. One solution of known concentration (either the acid or base) is used to determine the concentration of the other solution through a carefully monitored reaction. Typically, the titration reaction is monitored either using a pH probe or meter (which you will use today) or using a colored acid-base indicator (as you have used in the past).

Acid-base neutralization reactions can generally be described as an acid reacting with a base to yield a salt and water as shown below:

$$HA + OH^- \rightarrow A^- + H_2O$$

Most commonly, the $H^+$ from the acid reacts with the $OH^-$ from the base to produce the water and the remaining ions (anion or $A^-$ from the acid and the cation or $M^+$ from the base) combine to form a soluble salt.

An acid-base titration curve (a plot of pH of the acid vs. volume of base added, or pH of the base vs. volume of acid added) can give us some information about the relative strength of the acid and whether or not the acid is monoprotic or polyprotic. In today's experiment, you will be slowly adding base to an acidic solution and monitoring the pH of the solution as the base is added. Therefore, you will most likely see a titration curve like the one to the right:

The equivalence point represents the point of the titration where the initial amount of acid has been neutralized by the added base. Therefore, at the equivalence point: initial moles of acid $=$ moles of base added.

Key features of the titration curve are:

1. **LOW INITIAL pH.** Since the solution only contains acid in the beginning, the pH will be on the acidic side (less than 7). The initial pH of the titration depends on both the relative strength of the acid and the concentration of the acid and therefore should not be used to determine the relative strength of the acid.

2. **HIGH FINAL pH.** Since excess base has been added to the solution, the pH will be on the basic side (greater than 7), but it should level off somewhat at this point in the titration.

3. **EQUIVALENCE POINT.** This is the midpoint of the steep vertical portion of the titration curve. The equivalence point is also an indicator of relative strength of the acid. If the titration involves a strong acid with a strong base, the pH $= 7$ at the equivalence point. If the titration is of a weak acid titrated with strong base, the pH $> 7$ at the equivalence point. The exact pH of the titration at the equivalence point depends on the salt produced from the neutralization reaction.
4. **TITRATION CURVE SHAPE.** The characteristic S-shape of a titration curve corresponds to the reaction of one mole of protons from the acid reacting with one mole of base. If the acid is polyprotic, the titration curve will contain more than one S-curve (two for diprotic, three for triprotic, etc.).

![Titration Curve Shape](image)

**ACID IONIZATION CONSTANT**

One of the simplest ways to classify acids is based on strength. Acids can be classified as either strong or weak. An acid (HA) that is considered a **strong acid**, will dissociate 100% in water, meaning there will only be H⁺ (or H₃O⁺) and A⁻ in solution and none of the original form of the acid (HA). Any acid that dissociates less than 100% in water is considered a **weak acid**. This means that if you were to look on the atomic level at a weak acid solution, you would see some H⁺ (or H₃O⁺) and A⁻, but mostly HA.

The relative strength of acids can be found by comparing their \( K_a \) values, where \( K_a \) is called the acid ionization constant, and is a measure of how much an acid ionizes in water. The more an acid ionizes in water, the stronger the acid and the larger the \( K_a \) value.

Titration curves allow you to calculate the \( K_a \) of the acid. At half of the volume of base needed to reach the equivalence point, there is a special data point. At this point, only half of the acid has been neutralized (and converted into its conjugate base), so the amounts of acid and conjugate base must be equal. The \( K_a \) expression for the weak acid HA is given by

\[
K_a = \frac{[H_3O^+][A^-]}{[HA]}
\]

If the concentrations of HA and A⁻ are equal at the half-equivalence point, then the \( K_a \) of the weak acid must equal the hydronium ion concentration

\[
K_a = [H_3O^+]
\]

By taking the negative logarithm of the equation

\[
pK_a = pH
\]

therefore, the \( pH \) at the half-equivalence point of a titration equals the \( pK_a \) of the acid.
Another way of classifying acids (besides strength) is based on concentration. An acid is considered \textit{dilute}\ if it only has a few moles of acid molecules per a given volume. An acid is considered \textit{concentrated}\ if it has more moles of acid molecules per the same amount of volume. We express how concentrated an acid is by using \textit{molarity} (M or mol/L). Concentration only focuses on the number of moles of acid per volume, it does not give any hint to an acid's strength. Therefore, a 1.0 M weak acid solution is more concentrated than a 0.10 M strong acid solution.

To determine the concentration of an acid or base during a titration, we focus on the equivalence point. At the equivalence point, the number of moles of acid is equal to the number of moles of base.

\[
\text{HA} (aq) + \text{MOH} (aq) \rightarrow \text{MA} (aq) + \text{H}_2\text{O} (l)
\]

Notice that this relationship is in terms of moles, \textit{not} concentration. Therefore, \textit{at the equivalence point: initial moles of acid = moles of base added}. Looking at the titration curve for a monoprotic acid to the right, we can use the equivalence point to determine the concentration of the unknown acid.

Knowing the concentration of the base used in the titration and the volume of base needed to reach the equivalence point, we can determine the number of moles of base needed in the titration. Since we are focusing on the equivalence point, the number of moles of base needed must be equal to the number of moles of acid in the titration sample. Dividing the number of moles of acid by the volume of acid used in the titration, we can determine the concentration of the acid unknown.

\section*{ACID-BASE INDICATOR EQUIVALENCE POINT METHOD}

In many acid-base titrations, the equivalence point is signaled experimentally by the color change of an acid-base indicator, which is a weak organic acid added to the solution before the titration begins. The indicator’s molecular form (HInd) predominates in acidic solutions and exhibits a characteristic color. Its ionized form (Ind\textsuperscript{-}) predominates in basic solutions and exhibits a different color. The pH at which the indicator changes color is the pH at which the concentration of HInd equals the concentration of Ind\textsuperscript{-}. By writing the acid ionization constant expression for the indicator:

\[
K_a = \frac{[\text{H}_3\text{O}^+][\text{Ind}^-]}{[\text{HInd}]}
\]

it can be seen that when the concentration of HInd equals the concentration of Ind\textsuperscript{-}, the \(K_a\) equals the hydronium ion concentration

\[
K_a = [\text{H}_3\text{O}^+]\]

or, by taking the negative logarithm of the equation

\[
pK_a = pH
\]
This means that the pH at which the indicator changes color is equal to the indicator’s $pK_a$. However, the human eye needs the concentration of one form of the indicator (either the molecular form or the ionized form) to be about ten times greater than the other form to notice a color change. Therefore, we detect an indicator’s color change over a range of about 2 pH units. This is because the molecular form is ten times greater than the ionized form at a pH equal to the $pK_a + 1$, and the ionized form is ten times greater than the molecular form at a pH equal to the $pK_a - 1$. The pH color change ranges for some common indicators are given below.

![pH Color Change Ranges for Several Common Indicators](image)

The choice of indicator for an acid-base titration depends upon the approximate pH of the solution at the equivalence point of the titration. There are four scenarios for acid-base titrations.

1. **TITRATION OF A STRONG BASE AND A STRONG ACID.** When a strong base such as sodium hydroxide is titrated with a strong acid such as hydrochloric acid, the resulting solution at the equivalence point contains only soluble sodium chloride. Because sodium hydroxide is a strong base, the sodium ion is an inert conjugate acid. Because hydrochloric acid is a strong acid, the chloride ion is an inert conjugate base. Therefore, neither of these ions reacts with water, and the resulting solution will have a pH of 7. The choice of indicator for such a titration will be one in which its color change occurs at a pH of 7. From the list of indicators on the previous page, bromthymol blue would be the best choice for such a titration.

2. **TITRATION OF A STRONG BASE AND A WEAK ACID.** When a strong base such as sodium hydroxide is titrated with a weak acid such as acetic acid, the resulting solution at the equivalence point contains only soluble sodium acetate. Because sodium hydroxide is a strong base, the sodium ion is an inert conjugate acid. Because acetic acid is a weak acid, the acetate ion is a weak conjugate base. Therefore, the acetate ion reacts as a base with water, producing hydroxide ions, and the resulting solution will have a pH greater than 7. The choice of indicator for such a titration will be one in which its color change occurs at a pH greater than 7. By calculating the concentration of the acetate ion at the equivalence point, and by knowing the $K_b$ value for the acetate ion, the exact pH at the equivalence point can be determined. This will allow the best indicator to be selected.

3. **TITRATION OF A WEAK BASE AND A STRONG ACID.** When a weak base such as ammonia is titrated with a strong acid such as hydrochloric acid, the resulting solution at the equivalence point contains only soluble ammonium chloride. Because ammonia is a weak base, the ammonium ion is a weak conjugate acid. Because hydrochloric acid is a strong acid, the chloride ion is an inert conjugate base. Therefore, the ammonium ion reacts as an acid with water, producing hydronium ions, and the resulting solution will have a pH less than 7. The choice of indicator for such a titration will be one in which its color change occurs at a pH less than 7. By calculating the concentration of the ammonium ion at the equivalence point, and by knowing the $K_a$ value for the ammonium ion, the exact pH at the equivalence point can be determined. This will allow the best indicator to be selected.
4. **TITRATION OF A WEAK BASE AND A WEAK ACID.** When a weak base such as ammonia is titrated with a weak acid such as acetic acid, the resulting solution at the equivalence point contains only soluble ammonium acetate. Because ammonia is a weak base, the ammonium ion is a weak conjugate acid. Because acetic acid is a weak acid, the acetate ion is a weak conjugate base. Therefore, the ammonium ion reacts as an acid with water, producing hydronium ions, and the acetate ion reacts as a base with water, producing hydroxide ions. The pH at the equivalence point will depend on the $K_a$ and $K_b$ of the two ions. If the $K_a$ is larger, the pH at the equivalence point will be less than 7, and if the $K_b$ is larger, the pH at the equivalence point will be greater than 7.

**DERIVATIVE EQUIVALENCE POINT METHOD**

The equivalence point of an acid-base titration can also be signaled graphically by calculating the first derivative at each point along the titration curve. The titration curve below on the left was generated with *Logger Pro*.

![Titration Curve](image)

Each point on a curve has a line that passes through it, and is tangent to the curve itself. The slope of this tangent line is called the first derivative. If three random points on the curve are selected, A, B, and C, their first derivatives will be the slope of the line that is tangent to the curve at each point. The tangent lines for the three points are shown above on the right. Notice that at point B, which is the equivalence point, the slope of the tangent line is greater than at any other point on the titration curve. This fact can be used to determine the equivalence point of a titration. *Logger Pro* can calculate the slope of the tangent line at each point on a titration curve, and these values are shown below graphically.

The volume of base needed to produce the largest first derivative will be the volume of base necessary to reach the equivalence point of the titration.
PROCEDURE

1. Students will work individually for this experiment. Except for the laboratory handout, remove all books, purses, and such items from the laboratory bench top, and placed them in the storage area by the front door. For laboratory experiments you should be wearing closed-toe shoes. Tie back long hair, and do not wear long, dangling jewelry or clothes with loose and baggy sleeves. Open you lab locker. Put on your safety goggles, your lab coat, and gloves.

2. If the laptop computer is turned on, proceed to step 3. If the computer is off, turn it on, and when the Log On dialogue box appears, for User Name: type in your Saddleback (or IVC) email address, and for Password: type in your Saddleback (or IVC) password. If any other dialogue boxes appears, select No or Cancel or Close.

3. Open Logger Pro if it is not already open. Go to the Experiment menu and under Calibrate choose the channel with the pH probe (ex: “CH1:pH”). In the window that appears make sure the Calibration tab is chosen. Click on Calibrate Now. Rinse the pH meter with copious amounts of deionized water. Carefully blot dry. Place the pH meter in the pH 4 standard solution. Observe the voltage reading, found in the middle of the new window that opened up, and wait for the voltage reading to stabilize. In the field beneath Enter Value enter the pH value of the solution (4.00, not the voltage reading!) and click [ Keep]. Rinse the pH meter with copious amounts of deionized water. Carefully blot dry. Place the pH meter in the pH 10 standard solution and wait for the voltage reading to stabilize. In the field beneath Enter Value enter the pH value of the solution (10.00, not the voltage reading!) and click [ Keep]. When finished with this step click Done to close the window.

4. When not in use, place the pH sensor back into its storage solution.

5. Obtain one 50-mL buret (tolerance ±0.03 mL) from the cart. Obtain about 60 mL of 0.3 M sodium hydroxide in a clean beaker, and from its container record its actual molarity in your Data Table. Condition your buret by rinsing it three times with 5 mL portions of the sodium hydroxide solution, holding the buret in a horizontal position with the stopcock closed and rolling it to make sure that the sodium hydroxide solution wets the entire inside surface. Drain the sodium hydroxide solution through the buret tip into a waste beaker. Add the remaining sodium hydroxide to the buret and be sure that the tip of the buret is filled with sodium hydroxide and there are no air bubbles in the buret tip. Clamp the base-filled buret to the stand above your stir plate.

6. Obtain 25 mL of an unknown solution of a monoprotic acid and record the unknown number. Also obtain a 5-mL volumetric pipet (tolerance ±0.02 mL). Condition your pipet by drawing about 2 mL of the acid solution into the pipet and, holding the pipet in a horizontal position, rolling it to make sure that the acid solution wets the entire inside surface. Drain the acid solution through the pipet tip into a waste beaker. Do not use too much acid solution for the conditioning process, or you may not have enough left for your titration. Repeat this conditioning procedure two more times, each with about 2 mL of the acid solution.

7. Pipet 5.00 mL of the unknown monoprotic acid into a clean 250-mL beaker, record this volume in your Data Table, then add roughly 100 mL of deionized water to the acid solution. Add your small magnetic stir bar to your beaker and set the beaker on the stirring plate with the stirrer set at a low to moderate stir speed. Add your rinsed pH probe to the beaker so that the probe is resting gently on the bottom of the beaker and is not in contact with the stir bar. Clamp your pH probe in this position. Lower the base-filled buret as close to the reaction beaker as possible; however, you should still be able to easily manipulate the stopcock on the buret.
8. Click on the Data Collection button (the one with the clock on it), and you will see a Dialog Box. Change Mode from Time Based to Events with Entry. For Column Name type Volume and for Short Name type Vol. Change Units to mL then click Done.

9. Check to be sure that the pH and the volume can be entered to 2 decimal places. In the Data menu select Columns Options and then Volume. Under the Options tab, set the Displayed Precision to 2 decimal places. Click OK. Repeat, selecting Data, then Columns Options, then pH, and set the Displayed Precision to 2 decimal places. Click Done.

10. Click somewhere on your graph, then in the Options menu select Graph Options and then Axis Options. At the bottom of the Axis Options tab are the settings for the X-Axis. For Right: type 10.00, then click Done.

11. Before adding any sodium hydroxide solution to the beaker, click Collect. In the lower-left hand corner of the Logger Pro window, you will see the pH in real time. When it appears the pH has stabilized after stirring the acid solution for a while, click Keep. A new window will appear asking you to enter the volume of base added up to this point. Enter 0.00 mL into this window. This first data point (0.00 mL and corresponding pH) should now be recorded on the Data Table to the left, and a red dot should show up on the graph indicating this data point.

12. Before adding any sodium hydroxide solution to the beaker, record the initial reading of sodium hydroxide solution in the buret. Add 5 drops of the base to the reaction beaker. When the pH in the lower-left hand corner has stabilized, click Keep. Accurately read the buret, and then subtract this buret reading from your initial buret reading to determine the volume of sodium hydroxide solution that was added to the beaker. In the window that appears, enter the volume of sodium hydroxide solution that you added to the flask. You should then see this data point recorded on the Data Table to the left, and the graph should show a line connecting these two data points.

13. Add an additional 5 drops of the sodium hydroxide solution. Once the pH has stabilized, click Keep. Accurately read the buret, and then subtract this buret reading from your initial buret reading to determine the total volume of sodium hydroxide solution added to the beaker up to this point. Enter the total volume of sodium hydroxide solution added up to this point in the window.

14. Continue adding sodium hydroxide solution 5 drops at a time, (clicking Keep to record the stable pH reading each time, and recording the total volume) as long as the pH does not change by more than 0.2 pH units per each 5 drops. When the pH does change by more the 0.2 pH units, decrease the number of drops. Avoid any dramatic pH changes of greater than 1 pH unit. As you near the equivalence point there will be a dramatic change in pH with only a small amount of sodium hydroxide added, therefore, near the equivalence point add only 1 drop of sodium hydroxide solution at a time.

15. Once the pH has leveled out at a basic pH, add the sodium hydroxide again 5 drops at a time (clicking Keep to record the stable pH reading each time, and recording the total volume) for a few more data points. Only when the titration is complete, click Stop on Logger Pro. To save your data, from the menu bar select File, then Save, click on the pop down menu arrow next to the box labeled Save In:, and select desktop. Save your data as Exp 8, Your Name.

16. Now you will take the derivative of the data. In Logger Pro, under the heading Data, select New Calculated Column. Toward the bottom left of the new window that pops up, select Functions, then Calculus, then Derivative. In the middle button of this window, select Variable and then pH. Click Done to complete the process. To verify that Logger Pro did complete the derivative, there should be a third data column (mostly likely blue text) labeled CC (for calculated column) displayed in Logger Pro to the right of your titration curve data. The numbers there should be the derivative data. If all three columns are not visible, enlarge the data window until all three are visible.
17. Now you will display the first derivative of the titration curve and the titration curve on the same graph. Click on the pH axis label on your graph and select all of the above. Click OK. The graph will now show both the pH curve and the first derivative curve. Rescale the graph by clicking on the Autoscale Graph button (the one with the A on it), and make sure that all three data columns are visible by either enlarging the data window or contracting the graph window. Resave your Logger Pro data to the desktop.

18. On your graph, notice that the peak of the CC curve occurs at the inflection point of the titration curve. Look at the data contained in the columns. In the column labeled CC, find the largest number. The corresponding volume and pH are at the inflection point of the titration curve. This volume is the volume of sodium hydroxide solution that was added to reach the equivalence point. Record this volume in your Data Table, along with the pH at this point.

19. On your graph, place the cursor on the red titration curve, and notice at the bottom of the graph that the coordinates of the cursor are given: (volume, pH). Move the cursor along the red titration curve until you reach the volume of sodium hydroxide solution that was added to reach the half-equivalence point. Record the volume and pH of the half-equivalent point in your Data Table. Use these data to determine the $pK_a$ and the $K_a$ for the acid, and record these in your Data Table.

20. Finally, use your data to calculate the concentration of the monoprotic acid, and record this value in your Data Table.

21. In Logger Pro, from the File menu, select Print, click Print Footer, type your name, and click OK. The selected printer should be ISCI321000A. Click OK to print, and your graph will be sent to the printer in the lab room and printed there. Retrieve your graph and attach it to your lab report.

22. On your printed Logger Pro graph, label the following points in pen:
   (a) The point on the titration curve when the solution contains only the monoprotic acid
   (b) The point on the titration curve when the solution contains equal amounts of the monoprotic acid and its weak conjugate base
   (c) The point on the titration curve when the solution contains only the conjugate base

23. Clear the current data in by clicking Data and select Clear All Data, then close Logger Pro.

24. At the end of the experiment, all solutions can be rinsed down the sink. Do not let your magnetic stir bar go down the sink! Clean and dry the magnetic stir bar before returning it to your lab locker. Rinse your unknown container several times with tap water, then three times with deionized water, and then dry off the outside. Rinse the pipet and buret thoroughly, including their tips, several times with tap water, then three times with deionized water, and then dry off the outsiders. Return these items to the cart. Return all clamps to their proper drawers in the lab room, and place the stirring plate back in the fume hood. Attach your titration curve with its derivative plot to the end of the report.

25. Clean and wipe dry your laboratory work area and all apparatus. When you have completed your lab report have the instructor inspect your working area. Once your working area has been checked your lab report can then be turned in to the instructor.
## EXPERIMENT 8 LAB REPORT

Name: __________________________________________  Student Lab Score: __________
Date/Lab Start Time: ___________________________  Lab Station Number: __________

## DATA TABLE

<table>
<thead>
<tr>
<th>Unknown Acid Code Number</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Concentration of Sodium Hydroxide Solution</td>
<td>.</td>
<td>M</td>
</tr>
<tr>
<td>Volume of Unknown Monoprotic Acid</td>
<td>.</td>
<td>mL</td>
</tr>
<tr>
<td>Initial Buret Reading</td>
<td>.</td>
<td>mL</td>
</tr>
<tr>
<td>Volume of NaOH to Reach the Equivalence Point</td>
<td>.</td>
<td>mL</td>
</tr>
<tr>
<td>pH at the Equivalence Point</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>Volume of NaOH to Reach the Half-Equivalence Point</td>
<td>.</td>
<td>mL</td>
</tr>
<tr>
<td>pH at the Half-Equivalence Point</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>$pK_a$ of the Unknown Monoprotic Acid</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>1 $K_a$ of Unknown Monoprotic Acid</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>2 Concentration of the Unknown Monoprotic Acid</td>
<td>.</td>
<td>M</td>
</tr>
</tbody>
</table>

## CALCULATIONS

1.
1. Is your unknown acid a strong acid or weak acid? Explain your answer based upon both the equivalence point pH and the calculated $K_a$ value.

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
2. For a titration between potassium hydroxide and nitric acid:

(a) Sketch the titration curve for the potassium hydroxide solution being added to the nitric acid.

(b) Would you expect the pH at the equivalence point to be acidic, basic, or neutral? Explain based upon the salt ions that exist at the equivalence point.

(c) From the list of acid-base indicators in the introduction, select a suitable indicator for this titration.

3. For a titration between potassium hydroxide and hydrocyanic acid:

(d) Sketch the titration curve for the potassium hydroxide being added to the hydrocyanic acid.
(e) Would you expect the pH at the equivalence point to be acidic, basic, or neutral? Explain based upon the salt ions that exist at the equivalence point.

(f) If the concentration of potassium cyanide at the equivalence point is 0.10 M, and the $K_a$ for hydrocyanic acid is $6.2 \times 10^{-10}$, calculate the pH at the equivalence point.

(g) From the list of acid-base indicators in the introduction, select a suitable indicator for this titration.